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Introduzione
Gran parte delle problematiche dell’insegnamento si
evidenziano in relazione al rapporto di quest’ultimo con
la realtà. Ne consegue che un percorso educativo efficace
dovrebbe sempre partire dalla consapevolezza che la real-
tà presenta molteplici sfaccettature e che queste vengo-
no colte solo parzialmente da ogni singola disciplina. Si
delinea quindi come necessario il tentativo di sviluppare
negli alunni la progressiva coscienza di questa pluralità,
unitamente al desiderio di una riorganizzazione unitaria
del sapere.
Tale riflessione riconduce ad un altro aspetto centrale nel
processo di apprendimento: la ricerca del filo logico che
lega l’osservazione, l’esperienza diretta, il sedimento di
tale esperienza, traducibile nella formalizzazione di “im-
magini” quali metafore di quanto osservato ed esperito, e
il loro utilizzo nel processo di costruzione di propri sche-
mi mentali. Solo percorrendo le tappe di questo processo
è possibile plasmare nei discenti la capacità di intuizione
e di “saper vedere” con sguardo critico e consapevole la
realtà molteplice che li circonda.
Nel presente contributo si è inteso descrivere il percorso
didattico realizzato in un laboratorio d’informatica del Li-
ceo Scientifico Statale ‘A. Righi’ di Bologna con gli stu-
denti di una classe quarta “tradizionale”.
Tale lavoro è stato progettato allo scopo di collegare e
applicare le nozioni generali acquisite in aula, in relazione
alla struttura delle proteine, alle nuove conoscenze ine-
renti la Green Fluorescent Protein (GFP), precedente-
mente apprese durante la partecipazione della classe a un
percorso formativo di biologia molecolare presso i labora-
tori del “Life Learning Center” (LLC) della stessa città2 . A
tal fine, si è ritenuto che potesse risultare di grande effica-
cia l’utilizzo di un programma di visualizzazione molecolare
tridimensionale: RasMol 2.7.2.

“Per comprendere la struttura di una proteina
dovremmo considerare non solo la sua composizione chimica e
le sue proprietà fisiche, che corrispondono alla sua anatomia,

ma anche le sue specifiche reazioni e funzioni biologiche.”
                                                                        (Langmuir)

Premessa metodologico-didattica
Alla fine degli anni ‘70, lo sviluppo delle tecnologie del
DNA ricombinante e la pubblicazione delle prime sequen-
ze di acidi nucleici fecero emergere nella comunità scienti-
fica l’esigenza di poter disporre di archivi informatici di
libero accesso in cui immagazzinare i numerosi dati che si
andavano accumulando e che sarebbero stati prodotti nel
tempo in quantità sempre maggiore. In genere, è a tale
periodo che si fa risalire la nascita della bioinformatica,
quale materia multidisciplinare il cui scopo principale è la
gestione e l’analisi dell’enorme mole di dati provenienti
dagli studi della moderna biologia e dalle biotecnologie.
Relativamente di recente le attività di bioinformatica sono
state raggruppate con diversi altri approcci matematici,
quali la simulazione, il “modelling” e la statistica, in una
nuova disciplina a cui è stato attribuito il nome di biolo-
gia computazionale (Nature, Vol. 420, pag. 205, novem-
bre 2002). Sono proprio le metodologie bio-computazionali
che consentono di effettuare le analisi più innovative sul-
le biomolecole: confronto di biosequenze per la ricerca di
regioni di similarità, studi di evoluzione molecolare, studi
di predizioni strutturali.
Ad oggi, le banche dati biologiche sono numerosissime
e in esse sono raccolte le informazioni e i dati relativi alle
principali molecole biologiche (DNA, RNA, proteine) di
svariati organismi.
In riferimento alle proteine, l’analisi della loro sequenza
amminoacidica riveste un ruolo fondamentale nello stu-
dio e nella comprensione della loro funzione. In generale,
infatti, è la sequenza amminoacidica che determina la strut-
tura tridi mensionale di una proteina e quindi la sua fun-
zione, sebbene sia stata identificata una serie di peptidi,
detti chaperonine, che intervengono nel determinare il
corretto ripiegamento di alcune proteine. Inoltre, in molti
casi solo l’analisi della struttura 3D di una macromolecola
può aiutare a comprendere in quale modo e per quale mo-
tivo una determinata sequenza possa codificare una spe-
cifica funzione.

1 Il lavoro è tratto da una tesi di specializzazione svolta nell’ambito
della SSIS-Bologna, indirizzo Scienze Naturali, classe A060: “La
chimica di base per comprendere la struttura e le proprietà di mole-
cole complesse: le proteine” di Alessandra Barbin, a.a. 2003/2004.
2 A tale proposito si veda l’articolo “Chimica e biologia molecolare:
due facce della stessa medaglia. - Parte I” pubblicato in CnS, anno
XXVIII, n° 1, 2006.
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Attualmente, nonostante sia nota la sequenza amminoacidica
di un numero molto elevato di proteine, non è ancora stato
messo a punto un sistema che, a partire dalla sola sequenza,
riesca a predire la struttura proteica corrispondente in modo
affidabile. I due principali metodi utilizzati a tal fine rimango-
no, quindi, la cristallografia a raggi X e la spettroscopia a
risonanza magnetica nucleare (Nuclear Magnetic
Resonance, NMR) che consentono di determinare le coordi-
nate degli atomi costituenti la struttura molecolare. Tali coor-
dinate cartesiane, archiviate in files di formato standard facil-
mente scaricabili da Internet consultando una delle tante
banche dati proteiche disponibili (tra cui, ad esempio, Protein
Data Bank 3 , PDB) e per questo identificati di solito come
files PDB4 , vengono poi utilizzate per analisi computazionali
e grafiche al fine di ricostruire la struttura atomica del peptide
analizzato. È quest’ultimo aspetto che presenta significative
ricadute didattiche in relazione al tentativo di aiutare gli stu-
denti a costruirsi corrette ed efficaci “immagini mentali” ri-
guardanti gli aspetti curricolari affrontati.
Tra i programmi di grafica molecolare, scaricabili gratuita-
mente dalla rete, vi è RasMol. Tale programma presenta
due importanti caratteristiche: la notevole semplicità di
utilizzo e la possibilità di produrre rappresentazioni tridi-
mensionali “dinamiche” di discreta qualità.
In particolare, RasMol 2.7.25 (versione utilizzata nel pro-
getto) consente di ricostruire diversi tipi di rappresenta-
zioni strutturali 3D di una specifica proteina. Il tipo di

rappresentazione prescelto dipende dal particolare aspet-
to della struttura proteica che si desidera analizzare.
Da quanto appena riportato, risulta evidente il carattere
multidisciplinare e interdisciplinare dell’approccio
bioinformatico allo studio delle molecole proteiche, metodo
di analisi che si avvale in gran parte di competenze chimiche.

Visualizzazione tridimensionale della proteina verde fluo-
rescente
Nei giorni precedenti l’esercitazione, tutto il “materiale”
didattico necessario alla realizzazione dell’intervento (pro-
gramma RasMol 2.7.2 e file PDB relativo alle coordinate
atomiche della GFP) era stato memorizzato nella cartella
“Documenti” di ciascun computer del laboratorio
informatico, in modo tale che fosse di facile accesso per
gli studenti.
La lezione ha quindi avuto inizio con l’apertura del pro-
gramma grafico raswin (versione di RasMol eseguibile
per Windows) che consente la visualizzazione tridimen-
sionale della struttura proteica considerata. Cliccando
sull’icona relativa si aprono due finestre: la prima (RasMol
Version 2.7.2), a sfondo nero, dove si crea l’immagine
tridimensionale, l’altra, a sfondo bianco (RasMol
Command Line), in cui è possibile digitare specifici co-
mandi grazie alla presenza di una linea di testo.
Al fine di visualizzare la GFP nella prima delle due finestre,
gli studenti sono stati invitati a digitare i primi comandi
riportati su una dispensa consegnata loro in precedenza e
recante la successione delle operazioni da effettuare.

3 Indirizzo web del Protein Data Bank: http://www.rcsb.org/pdb/
4 Per ulteriori informazioni relative alla bioinformatica e ai file
PDB si consiglia di fare riferimento al testo “Introduzione alla
bioinformatica” riportato in bibliografia e all’articolo “La didattica
in 3D: come studiare le proteine al computer” di Giovanni
Casavecchia - CnS, anno XXVII, n° 5, 2005.

5 Scaricabile dal sito http://www.bernstein-plus-sons.com/software/
rasmol

SCHEDA 1 - Visualizzazione tridimensionale della proteina verde fluorescente
(GFP: Green Fluorescent Protein) mediante il programma RasMol 2.7.2

La proteina verde fluorescente (GFP), utilizzata nelle esercitazioni di laboratorio effettuate
presso il “Life Learning Center”, è stata isolata dalla medusa tropicale Aequorea victoria.
Tale organismo, come molti altri celenterati, manifesta il fenomeno della bioluminescenza,
riconducibile alla presenza della proteina GFP all’interno di cellule specifiche. Questa pro-
teina ha una caratteristica forma cilindrica (β-barile) e, al suo interno, racchiude un cromoforo
sensibile alla luce ultravioletta. Esso, infatti, se colpito da tali lunghezze d’onda, tende a
emette a sua volta luce visibile nella lunghezza d’onda del verde.

 Il nostro scopo, nella presente esercitazione, è di visualizzare la proteina e analizzarne le principali caratteristiche.

Apriamo il programma raswin cliccando sull’icona relativa.

Utilizzando la barra dei comandi (BC) del programma di visualizzazione apriamo il file PDB, relativo ai dati cristallografici della
GFP, premendo in successione:
File → Open →  Cartella contenente il programma PDB (ad esempio: “EsercitazBioInf”) → File PDB contenente i dati cristallografici
(ad esempio: “1EMA-GFP”) → Apri.
[La proteina viene visualizzata in modalità wireframe (Display) e CPK (Colours)].
Innanzitutto, cerchiamo di riconoscere le diverse porzioni della struttura secondaria della proteina.

A tal fine, digitiamo nella RasMol Command Line (CL), che si apre insieme a raswin, i seguenti comandi:

CL zoom 150 → Invio
CL structure → Invio
BC Colours → Structure
BC Display → Cartoons
BC Options → Specular
(CL select turns → Invio)

Nella struttura della proteina, costituita nella rappresentazione da 1717 atomi,
si possono riconoscere 4 α-eliche, 11 β-foglietti e 20 loop (originati dalla
presenza di specifici legami a idrogeno tra porzioni contigue della catena
amminoacidica ove questa è priva di una specifica struttura secondaria). È
evidente la forma a barile della proteina che risulta essere attraversata per tutta
la sua lunghezza da un’unica α-elica solo apparentemente suddivisa in quattro
porzioni distinte (Figura 1).
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CL select protein → Invio
CL hbonds on → Invio
BC Display → Backbone

Ora mettiamo in evidenza il cromoforo (questo nel file PDB viene indicato con la sigla cro).

CL select cro → Invio
CL colour green → Invio
BC Display → Ball and stick

CL select protein → Invio
BC Display → Strands
CL hbonds off → Invio

Il cromoforo, porzione più delicata di tutto il complesso molecolare, è collocato
nel centro geometrico della proteina in una posizione protetta (Figura 4).
Con il termine cromoforo s’intende un gruppo atomico insaturo presente in
alcune molecole o composti organici che ha la capacità di assorbire radiazione
elettromagnetica nella regione del visibile e dell’ultravioletto e che rende colora-
te le sostanze in cui è contenuto.
Talvolta sono necessari più gruppi cromofori affinchè una sostanza cromogena
(ossia un composto contenente uno o più cromofori) appaia colorata.

Ora evidenziamo gli amminoacidi polari e non polari della proteina. Queste porzioni sono diversamente distribuite nella
struttura proteica e la loro posizione relativa ha grande importanza in rapporto alla solubilità della proteina stessa.

CL  select polar → Invio
CL colour red → Invio
BC Display → Ball and Stick

(sfere e bastoncini)
CL  select hydrophobic → Invio
CL colour white → Invio
BC Display → Ball and Stick
CL select backbone → Invio
BC Display → Ribbons

(nastri)
CL select protein → Invio
BC Display → Spacefill

(sfere piene)
BC Options → Specular

È evidente una maggiore distribuzione dei residui amminoacidici polari sulla
superficie esterna del β-barile e, conseguentemente, una maggiore presenza di
resuidi idrofobici all’interno della struttura proteica (Figure 5 e 6). Questo è
dovuto al fatto che la GFP, essendo una proteina citoplasmatica, deve poter
essere solubile in un ambiente acquoso. Tuttavia, la non trascurabile presenza
di residui idrofobici direttamente a contatto con l’ambiente esterno rende que-
sta molecola facilmente purificabile mediante cromatografia ad interazione
idrofobica (HIC).

Cliccando con il tasto sinistro del mouse su uno degli amminoacidi della proteina se ne può leggere la natura sulla RasMol
Command Line.

Ora osserviamo più da vicino il cromoforo.
Cliccando con il tasto sinistro del mouse su uno degli atomi del cromoforo se ne può leggere la natura chimica sulla RasMol
Command Line. Oppure si può utilizzare la funzione Pick Label (sotto la funzione Settings nella barra dei comandi) con la
stessa

CL restrict cro → Invio
CL zoom 250 → Invio

BC Colours → CPK
CL zoom 150 → Invio
CL colour green → Invio

La colorazione PCK distingue gli atomi in base alla loro specie chimica.
Il cromoforo è costituito da tre amminoacidi (Ser o Thr65 - Tyr66 - Gly67) in
seguito a loro ciclizzazione, deidratazione e ossidazione. Esso in realtà è diretta-
mente collegato all’ α-elica centrale. Gli anelli a 5 e 6 atomi di carbonio sono
complanari e l’intero cromoforo è provvisto di un esteso sistema di doppi legami
coniugati: caratteristiche alla base delle sue proprietà fluorescenti (Figure 7e8).
[Cromoforo → “croma” = colore + “foro” = porto]

Evidenziamo alcuni dei principali amminoacidi polari che interagiscono direttamente, mediante legami a idrogeno, con il
cromoforo contribuendo, in tal modo, sia alla sua stabilità sia probabilmente alle sue proprietà fluorescenti.
(Anche in questo caso le informazioni relative agli amminoacidi si ottengono dalla lettura del file PDB).

CL select protein → Invio
BC Colours → Structure
BC Display → Backbone
CL select 69,94,96,148,203,222 → Invio
BC Display → Balls and sticks
CL restrict 69,94,96,148,203,222,cro → Invio
CL zoom 250 → Invio
BC Display → Spacefill

Cliccando con il tasto sinistro del mouse su un residuo amminacidico se ne può leggere la natura sulla RasMol Command
Line.

Vengono evidenziati i numerosi legami a idrogeno (161) che legano stabilmente tra
loro i β-foglietti conferendo alla proteina la sua caratteristica struttura secondaria.
Questi stessi legami stabilizzano anche le α-eliche ed i loop. Si tratta di legami
deboli che si formano per interazione tra l’ossigeno carbossilico di un
amminoacido ed un gruppo amminico di un altro amminoacido della sequenza
(Figura 3).



La proteina è così apparsa in modalità wireframe: questo
tipo di rappresentazione consente di visualizzare tutti gli
atomi descritti nel file di coordinate (carbonio in grigio,
ossigeno in rosso e azoto in bluette) come intersezioni di
segmenti che rappresentano i legami chimici esistenti tra
gli atomi stessi (Valle et al., 2003).
Gli allievi sono quindi stati esortati a ruotare l’immagine (po-
sizionando il mouse sulla figura e mantenendone il tasto
sinistro premuto mentre lo si sposta) e a notare se in essa
osservavano “architetture” particolari. Al fine di favorire tale
ricerca, sono stati loro suggeriti i comandi per ingrandire la
struttura; tuttavia, nemmeno in questo modo gli studenti
sono riusciti a distinguere particolari significativi.
Si è allora deciso di far digitare loro i comandi successivi
in modo da cambiare modalità di rappresentazione: è ap-
parsa così evidente la struttura terziaria della proteina GFP
(Figura 1), costituita da quattro porzioni ad α elica (in
fucsia), da undici foglietti ripiegati β (in giallo) e da venti
ripiegamenti β o anse (in bluette).

Per evitare di trasmettere agli studenti concetti errati è
stato immediatamente chiarito loro che la figura osservata
non era una “fotografia” della realtà, bensì solo un’utile
rappresentazione grafica, come pure tutte le immagini che
avrebbero esaminato successivamente.
A partire dalla struttura tridimensionale visualizzata, sono
quindi state descritte le principali caratteristiche della prote-
ina in esame. La Green Fluorescent Protein, costituita da
238 amminoacidi, è stata isolata per la prima volta dalla me-
dusa tropicale Aequorea victoria (http://
www.biochemtech.uni-halle.de/…). Essa, in realtà, è un
dimero funzionale (Figura 2) costituito da due subunità iden-
tiche associate tra loro mediante interazioni deboli fra
amminoacidi idrofobi e idrofili presenti alla sua superficie
(Tsien, 1998).
Ciascuna subunità della proteina presenta una struttura
terziaria cilindrica costituita da 11 foglietti ripiegati β, che
ne formano le “pareti”. Inoltre, mentre tre piccole porzioni
ad α elica costituiscono una sorta di “coperchio” o “dia-
framma” sulle parti terminali di ciascuna struttura
cilindrica, la quarta ed ultima porzione (un segmento irre-
golare ad α elica visibile solo parzialmente nella Figura 1)
si snoda lungo l’asse longitudinale di ciascun cilindro

Figura 1 Struttura terziaria di ciascuna subunità proteica.

(Tsien, 1998). Nel centro geometrico di quest’ultimo è lo-
calizzato il cromoforo, che deriva dalla ciclizzazione di tre
amminoacidi appartenenti proprio alla quarta porzione ad
α elica. Grazie alla presenza di un elevato numero di lega-
mi a idrogeno tra i foglietti ripiegati β, ogni dominio del
dimero risulta estremamente stabile e compatto, evitando,
in tal modo, l’accesso al cromoforo da parte di ligandi
diffusibili potenzialmente nocivi. Nel suo complesso, que-
sto tipo di ripiegamento (beta-barrel: barile beta), in cui i
foglietti β si dispongono alla superficie e le α eliche all’in-
terno della struttura, rappresenta una nuova classe di pro-

Figura 2 Struttura quaternaria della proteina GFP.

teine definite beta-can (http://dwb.unl.edu/...).
Visto il ruolo fondamentale che i legami a idrogeno svolgo-
no nella formazione delle strutture secondarie, si è ritenuto
utile visualizzarli in una fase successiva. Al fine di poter
osservare più chiaramente questi stessi legami (161), è sta-
ta cambiata la tipologia di rappresentazione (Backbone:
”colonna vertebrale”), in modo tale che la proteina venis-
se raffigurata mediante una linea spezzata unente i carboni
α della catena principale (Figura 3) e i legami a idrogeno
apparissero come linee “puntinate”.

Figura 3 Legami a idrogeno stabilizzanti il ripiegamento a
barile di ciascun dominio del dimero.
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A questo punto sono stati indicati alla classe i comandi
per evidenziare, all’interno della struttura a beta barile, il
cromoforo (cro) (Figura 4).

Anche in relazione a questo, dopo averne dato la defini-
zione generale (“croma” = colore, “fero” = porto), sono
state descritte le caratteristiche principali. Esso è, senza
dubbio, la porzione più delicata del complesso proteico
ed è presumibilmente per questo motivo che si trova al
centro di ciascuna subunità. Come già accennato, è for-
mato da tre residui amminoacidici (65, 66, 67) interni alla
sequenza e corrispondenti, rispettivamente, a una serina,
a una tirosina e a una glicina (Ser-Tyr-Gly).
Il cromoforo funzionale si genera, attraverso un meccani-
smo sequenziale di ciclizzazione post-trascrizionale, in un
processo autocatalitico nel quale, cioè, non è richiesto
l’intervento né di cofattori, né di componenti enzimatiche.
In tale processo, fondamentale è la presenza della glicina
che non può essere sostituita da nessun altro
amminoacido. La reazione di formazione del cromoforo è
termosensibile: la resa diminuisce per temperature supe-
riori ai 30 °C.
Tuttavia, una volta formatasi completamente, la proteina
GFP è estremamente resistente ai processi di denaturazione
sia fisici che chimici (http:// dwb.unl.edu/...).
Di seguito, è stata presa in considerazione la distribuzio-
ne degli amminoacidi polari e apolari della proteina: que-
sti, infatti, risultano diversamente distribuiti nella struttu-
ra terziaria influendo, in tal modo, sulla solubilità della
proteina stessa.
Dopo aver digitato i comandi opportuni e aver ruotato la
proteina (Figura 5), è apparsa evidente la maggiore distri-
buzione dei residui amminoacidici polari (in colore rosso)
sulla superficie esterna del beta barile e,
conseguentemente, la maggiore presenza dei residui
idrofobici (in colore bianco) all’interno della struttura
proteica.

Si è così potuto spiegare agli studenti come questa carat-
teristica non sia casuale, ma diretta conseguenza del
ripiegamento della catena polipeptidica della GFP, guida-
to dalla forte tendenza dei residui idrofobici ad escludere
l’acqua (componente principale del citoplasma). In que-
sto modo, mentre le catene polari superficiali, interagendo
con il citoplasma, promuovono la solubilizzazione della
proteina, i residui non polari, protetti il più possibile al-
l’interno della struttura a barile, conferiscono a questa
un’elevata stabilità termodinamica. A conferma di quanto
espresso, è stata nuovamente cambiata la tipologia di rap-
presentazione (Spacefill): questa, raffigurando gli atomi
costituenti la proteina con “sfere piene” di raggio equiva-
lente ai raggi atomici di Van der Waals, consente una facile
definizione della superficie e del volume occupato dalla
biomolecola (Figura 6).

Figura 4 Posizione centrale del cromoforo all’interno della
struttura a barile.

Figura 5 Distribuzione degli amminoacidi idrofilici (rosso) e
idrofobici (bianco).

Figura 6 Subunità proteica in formato Spacefill: è evidente
l’estrema compattezza della struttura terziaria.



A tale proposito, la classe è stata invitata a memorizzare
quanto appena esposto e la struttura visualizzata poiché,
nelle successive lezioni, inerenti le tecniche
cromatografiche, il concetto sarebbe stato ripreso e ap-
profondito (sarà illustrato e discusso nel prossimo contri-
buto, Parte III).
Si è allora deciso di tornare ad osservare più da vicino il
cromoforo, visualizzandolo mediante la colorazione CPK
che consente di distinguerne gli atomi in base alla loro
specie chimica (Figure 7 e 8).

Figura 7 Cromoforo in formato CPK: è evidente la disposizio-
ne complanare dei due anelli.

Figura 8 Cromoforo in formato Sticks: residui amminoacidici
costituenti ciclizzati

Agli studenti è stata fatta notare la presenza in esso di due
anelli complanari a cinque e sei atomi di carbonio, struttura
molecolare sulla quale sono stati invitati a ragionare.
Utilizzando le loro conoscenze pregresse di chimica gene-
rale e di chimica organica si è giunti a stabilire che:
1) i due anelli risultano effettivamente giacenti sul medesi-
mo piano, data l’ibridazione sp2 degli atomi di carbonio
e azoto costituenti,
2) l’atomo di carbonio intermedio tra i due anelli, essendo
anch’esso ibridizzato sp2, deve presentare un doppio le-
game.

Ne risulta così una struttura altamente insatura a causa
dell’elevato numero di doppi legami coniugati. Questi, ol-
tre a conferire una considerevole stabilità al cromoforo,
risultano anche i principali responsabili delle sue proprietà
fluorescenti.
A tale proposito, la domanda di una studentessa ha dato
l’opportunità di spiegare alla classe il processo che è alla
base della fluorescenza. Così, disegnando alla lavagna lo
schema riportato in Figura 9, questo fenomeno è stato bre-
vemente illustrato.

Figura 9 Schematizzazione del processo radiativo di fluore-
scenza.

Il processo di fluorescenza consiste nell’emissione spon-
tanea di radiazione elettromagnetica da parte di una mole-
cola che si trova in uno stato elettronicamente eccitato. Il
nome del fenomeno deriva dalla fluorite, minerale costitu-
ito da ioni calcio e ioni fluoruro (CaF2) che, in alcuni casi,
può manifestare appunto il fenomeno della fluorescenza.
Nella maggior parte delle molecole, l’assorbimento di una
radiazione di opportuna energia provoca una transizione
di un elettrone dallo stato fondamentale ad uno stato ecci-
tato. Immediatamente dopo il salto energetico, ha luogo
una serie di eventi, estremamente rapidi e in competizione
tra loro, volti a rilasciare l’energia assorbita dalle molecole.
Il fenomeno più comune che si realizza in queste circostan-
ze è il così detto decadimento non radiativo6 in cui l’ener-
gia eccedente si trasferisce dalle molecole eccitate alle al-
tre molecole circostanti sotto forma di energia di vibrazio-
ne, rotazione e traslazione. L’energia di eccitazione può
essere rilasciata anche sotto forma di agitazione termica
dell’ambiente, ossia come calore, e allora si parla di de-
gradazione termica. Oppure, le molecole possono liberar-
si dell’energia acquisita sotto forma di un fotone tramite il

6 Al riguardo è stato puntualizzato agli studenti che l’aggettivo
radiativo deriva dal termine radiazione e, pertanto, non va confuso
con radioattivo.
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processo di decadimento radiativo, di cui la fluorescenza
è un esempio.
In ultimo, le molecole eccitate possono sfruttare l’energia
eccedente per prendere parte ad una reazione chimica.
Tra questi diversi processi alla fine si realizzerà quello più
rapido in ordine di tempo, ossia quello cineticamente favo-
rito e/o con maggiore probabilità relativa di verificarsi. Così,
ad esempio, è molto più probabile che la perdita di energia
di eccitazione si realizzi come dispersione di calore nel-
l’ambiente in seguito alla collisione tra molecole (trasferi-
mento di energia che si attua in tempi dell’ordine di 10-13 s),
piuttosto che attraverso l’emissione per fluorescenza (pro-
cesso a vita media di circa 10-9 s). Tuttavia, in alcune condi-
zioni specifiche, quali la presenza di doppi legami coniuga-
ti e, quindi, di delocalizzazione elettronica e di “anelli rigi-
di” a livello della struttura della molecola eccitata, il pro-
cesso di fluorescenza può essere favorito rispetto agli altri
fenomeni e quindi realizzarsi.
Questo spiega il perché non tutte le molecole eccitate dia-
no luogo a fluorescenza o fosforescenza, processi, come
già detto, di decadimento radiativo. Per quanto riguarda la
fluorescenza, l’assorbimento iniziale innalza l’energia del-
la molecola dallo stato fondamentale S

0
 ad uno stato elet-

tronico eccitato, ad esempio S
3
 (Figura 9). Immediatamente

dopo il salto energetico, ha luogo la così detta conversio-
ne interna: indipendentemente da quale livello energetico
eccitato sia stato raggiunto, la molecola subisce una rapi-
da e parziale perdita di energia, emessa in forma non ra-
diante come energia termica dell’intorno, in seguito agli
urti con le molecole circostanti. In questo modo, le mole-
cole eccitate raggiungono rapidamente il più basso stato
eccitato S

1
, dal quale tornano poi al livello energetico fon-

damentale mediante l’emissione di un quanto di luce, os-
sia rilasciando l’eccesso di energia residua in forma di ra-
diazione. La radiazione “fluorescente” così ottenuta pre-
senta una frequenza ν, e quindi un’energia, inferiore a quella
della radiazione eccitante assorbita, poiché la transizione
finale, dal più basso livello eccitato S

1
 al livello elettronico

fondamentale S
0
, ha luogo solo dopo che una certa quanti-

tà di energia assorbita si è “scaricata” in altro modo. La
lunghezza d’onda λ della radiazione emessa è tanto minore
quanto maggiore è il salto energetico verificatosi: così l’on-
da elettromagnetica rilasciata sarà visibile come luce blu
fluorescente se il salto energetico è elevato, come luce
verde o rossa fluorescente se il salto è ridotto. Ciò spiega
anche perché per l’eccitazione sia necessaria la radiazione
ultravioletta che possiede una λ inferiore a quella della
luce visibile. In generale, le molecole che danno fluore-
scenza presentano, a livello della loro struttura molecolare,
anelli rigidi e complanari e un numero rilevante di doppi
legami coniugati, con conseguente delocalizzazione elet-
tronica estesa. Questo infatti è ciò che si riscontra anche
nella struttura molecolare del cromoforo della proteina verde
fluorescente, come appare evidente nelle Figure 7 e 8.
Nel caso della fluorescenza, la radiazione emessa sponta-
neamente cessa subito dopo che si è estinta quella re-
sponsabile dell’eccitazione. Al contrario, nella
fosforescenza l’emissione spontanea può persistere a lun-
go (anche ore, ma il più delle volte per secondi o frazioni di
secondo) dopo la fine dello stimolo. Questa differenza fa
supporre che, mentre nella fluorescenza si verifica una con-
versione immediata dell’energia assorbita in energia
riemessa, la fosforescenza comporti l’accumulo dell’ener-
gia di eccitazione in una sorta di “serbatoio” dal quale poi

essa sfuggirebbe lentamente. Tuttavia, poiché la spiega-
zione del processo di fosforescenza richiede conoscenze
chimico-fisiche molto approfondite e complesse ed esula
dagli intenti specifici di questa trattazione, l’argomento in
questa sede non sarà approfondito oltre quanto detto.
Ritornando all’esercitazione di bioinformatica, da ultimo sono
stati fatti visualizzare alla classe alcuni dei principali
amminoacidi polari che, interagendo direttamente con il
cromoforo, contribuiscono a determinarne l’alta stabilità e,
probabilmente, parte delle proprietà fluorescenti (Figura 10).

Figura 10 Posizione degli amminoacidi polari interagenti con
il cromoforo (Spacefill) nella struttura terziaria della subunità

proteica (Backbone).

Tra questi particolarmente importanti risultano le glutamine
69 e 94, l’arginina 96, l’istidina 148, la treonina 203 e il glutamato
222, ciascuno dei quali interagisce direttamente, attraverso
legami a idrogeno, con il cromoforo (Figura 11) (Tsien, 1998).

Figura 11 Principali amminoacidi polari stabilizzanti il
cromoforo.



I primi tre amminoacidi, inoltre, sembra che partecipino at-
tivamente alla stabilizzazione e alla delocalizzazione della
carica sul cromoforo stesso. In questo articolo si riporta
anche la procedura relativa alla visualizzazione tridimen-
sionale dell’enzima di restrizione EcoRI, noto agli studenti
come uno degli strumenti principali della tecnologia del
DNA ricombinante e da loro utilizzato per digerire il DNA
plasmidico durante l’esercitazione del DNA Fingerprinting
presso il LLC7 .

7 Illustrato nel prossimo contributo (Parte III).

Come momento di consolidamento delle conoscenze apprese
e di verifica, ai ragazzi è stato infatti assegnato il compito di
visualizzare tale enzima fuori dall’ambito scolastico, fornendo
loro quale strumento di lavoro la dispensa relativa (SCHEDA
2), recante la successione dei comandi da digitare, e un CD-
ROM sul quale era stato in precedenza memorizzato tutto il
“materiale” didattico necessario allo scopo.

SCHEDA 2 - Visualizzazione tridimensionale dell’enzima di restrizione EcoRI
(Escherichia coli restriction enzyme I) mediante il programma RasMol 2.7.2

EcoRI è un enzima di restrizione (dimero funzionale) isolato dal batterio Escherichia coli. Esso è in grado di legarsi alla doppia elica
di DNA sulla quale riesce a riconoscere una specifica sequenza consenso (sequenza di restrizione) lunga 6 pdb. L’enzima, a tutti
gli effetti un’endonucleasi, taglia la doppia elica di DNA all’interno di tale sequenza (GAATTC ): più precisamente tra l’adenina e
la guanina, sia sul filamento 3’→ 5’ che sul filamento complementare 5’→ 3’. Per la caratteristica modalità di taglio vengono
prodotte due estremità libere dette stycky ends o estremità apiccicose.

Il nostro scopo, nella presente esercitazione, è quello di visualizzare la proteina (presente nel file PDB come monomero), la
sequenza di restrizione sul DNA (presente nel file come singolo filamento) e il dominio di legame (sito attivo) di EcoRI al DNA.

Apriamo il programma raswin cliccando sull’icona relativa.
Utilizzando la barra dei comandi (BC) del programma di visualizzazione apriamo il file PDB, relativo ai dati cristallografici
dell’enzima, premendo in successione:

File → Open → (EsercitazBioInf) → 1ERI → Apri.

[La proteina viene visualizzata in modalità wireframe (Display) e CPK (Colours)].

Innanzitutto, cerchiamo di riconoscere il DNA, la porzione proteica e la struttura secondaria di quest’ultima.
A tal fine digitiamo nella RasMol Command Line (CL), che si apre insieme a raswin, i seguenti comandi:

CL zoom 150 → Invio
BC Colours → Structure
BC Display → Cartoons

[CL structure → Invio]

BC Display → Sticks
CL select backbone → Invio
BC Display → Ribbons
BC Colours → Monochrome

Si possono riconoscere distintamente un singolo filamento di DNA legato a una
subunità dell’enzima. Questa presenta 11 α-eliche, 16 β-foglietti e 25 loop
(originati dalla presenza di specifici legami a idrogeno (192) tra porzioni conti-
gue della catena amminoacidica ove questa è priva di una specifica struttura
secondaria).
Il secondo filamento di DNA e la seconda subunità dell’enzima non sono
visualizzabili

Vengono evidenziate come “fettucce” la catena carboniosa della proteina e lo
scheletro del filamento di DNA. Rimangono visibili i residui amminoacidici
della proteina e le basi azotate del DNA.

Ora mettiamo in evidenza la sequenza di restrizione (GAATTC) presente sul frammento di DNA e riconosciuta dal sito attivo
dell’enzima EcoRI.
(Le informazioni relative si ottengono dalla lettura del file PDB).

Cliccando con il tasto sinistro del mouse su una base azotata del DNA se ne può leggere la natura sulla RasMol Command Line.

CL select *B → Invio
CL select G5 → Invio
CL colour green → Invio
CL select A6,A7 → Invio
CL colour red → Invio
CL select T8,T9 → Invio
CL colour yellow → Invio
CL select C10 → Invio
CL colour violet → Invio

*B = filamento di DNA
G = guanina
A = adenina
T = timina
C = citosina
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Infine, mettiamo in evidenza la sequenza amminoacidica del sito attivo dell’enzima EcoRI attraverso cui questo riconosce la
sequenza di restrizione presente sul frammento di DNA.
(Anche in questo caso le informazioni relative agli amminoacidi si ottengono dalla lettura del file PDB).
Cliccando con il tasto sinistro del mouse su un residuo amminacidico se ne può leggere la natura sulla RasMol Command Line

CL select *A → Invio
CL select 115,137,138,140,141,142,144,145,200,203,301 → Invio
CL colour magenta → Invio

CL restrict 115,137,138,140,141,142,144,145,200,203,301,*B → Invio
BC Display → Ball and stick

CL select *B → Invio
BC Display → Sticks
BC Display → Spacefill

*A = proteina
115,137,ecc. = amminoacidi

Restringo la visualizzazione al filamento di
DNA ed agli amminoacidi del sito attivo.

Viene evidenziata l’interazione diretta tra
residui amminoacidici del sito attivo di EcoRI
e lo scheletro del filamento di DNA.

Riflessioni didattiche
Nella sua interezza, il progetto didattico presentato in
questo articolo ha consentito di applicare nozioni di chi-
mica studiate in precedenza e di introdurne di nuove, così
da costruire una “rete di concetti”.
In particolare, il percorso qui descritto consente di realizza-
re importanti collegamenti con la chimica delle proteine. A
tale proposito si vedano il concetto di radicale idrofobico e
idrofilico e l’importanza del mantenimento di condizioni
d’ambiente costanti, le sole che permettono la conserva-
zione della struttura tridimensionale della proteina.
Allo stesso modo, la visualizzazione tridimensionale me-
diante il programma RasMol della proteina GFP ha con-
sentito di verificare concretamente quanto sia fondamen-
tale conoscere la teoria del legame chimico e ciò che ne
consegue al fine di apprezzare con piena consapevolezza
ciò che in genere viene solamente descritto.
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